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1 Introduction
This manual is designed to help users of Signature Series product line, also known as broadband

instruments, to get familiar with the system and how to use it. The manual includes chapters

covering how to get the instrument up and running as quickly as possible, functional testing, software

information, and tips for maintenance and troubleshooting. Take a look at Principles of Operation -

Signature for more in depth understanding on how the instrument works. For information about how to

communicate, control and develop for your instrument, consult our Integrators Guide - Signature.

Nortek online

At our website, www.nortekgroup.com, you will find technical support, user manuals, and the latest

software and firmware. General information, technical notes, and user experience can also be found

here.

Nortek FAQ

Our old forum where users from all over the world met to discuss and shared their experience with

Nortek instruments has been converted to an FAQ section. If you have comments, questions,

application tips, suggestions for improvements, or simply want to learn from others or share your own

experience, we encourage you to comment on the relevant FAQ or start a topic in our new forum.

Your feedback is appreciated

If you find errors, omissions or sections poorly explained, please do not hesitate to contact us. We

appreciate your comments and your fellow users will as well.

Contact Information

We recommend first contacting your local sales representative before the Nortek main office. If you

need more information, support or other assistance, you are always welcome to contact us or any of

our subsidiaries by email, phone or fax.

Email: inquiry@nortekgroup.com for general inquiries or support@nortekgroup.com for technical

support

Phone: +47 67 17 45 00

Fax: +47 67 13 67 70

You can also write us at:

Nortek AS

Vangkroken 2

1351 RUD

Norway

Version/revision Date Comments

2014.1 28.10.2014 Release

2014.2 17.11.2014

2014.3 02.12.2014

2015.1 09.06.2015 Software updates

2015.2 24.11.2015 Instrument updates

2016.1 29.02.2016 Software updates

2016.2 15.09.2016 Software updates

2017.1 10.02.2017

https://support.nortekgroup.com/hc/en-us/articles/360029835831-Principles-of-Operation-Signature
https://support.nortekgroup.com/hc/en-us/articles/360029835831-Principles-of-Operation-Signature
https://support.nortekgroup.com/hc/en-us/articles/360029513952-Integrators-Guide-Signature
http://www.nortekgroup.com
https://support.nortekgroup.com/hc/en-us/categories/360001412211-Frequently-Asked-Questions
https://support.nortekgroup.com/hc/en-us/community/topics
mailto:inquiry@nortekgroup.com
mailto:support@nortekgroup.com
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2017.2 08.12.2017

2018.1 26.06.2018

2018.2 21.09.2018

2021.1 04.06.2021 General updates, new software

examples

2022.1 09.02.2022 General updates, formatting

2022.2 29.09.2022 Minor updates
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2 System Overview 250/500/1000
Signature1000, Signature500 and Signature250, three advanced five-beam current profiling systems,

are made with the most demanding scientific user in mind. Built on the entirely new AD2CP platform,

the Signature1000, Signature500 and Signature250 are designed for unprecedented performance in

high energy turbulent environments, while also giving users the freedom to employ several

measurement schemes at one time.

The figures below show the Signature1000 system but can be easily translated to the Signature500

and Signature250. The Signature1000 and Signature500 sensor heads have five acoustic

transducers, four slanted at 25 degrees from vertical, and a fifth vertical beam. The Signature250

uses beams angled at 20 degrees and an optional fifth vertical beam. Note that the optional vertical

beam on the Signature250 operates at 500 kHz. On the Signature500 and Signature1000 all beams

operate at the same frequency. For dimensions, please refer to the specific instrument data sheet,

available for download from our website. 

The pressure sensor, temperature sensor and LED light are all visible from the outside. Note also the

beam configuration, with Beam 1 pointing in the positive X-direction (see the engraved axis definition

on the head).

Figure 1. Signature1000 beam and sensor overview

http://www.nortekgroup.com
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Figure 2. Signature1000 housing, end cap and connectors overview

Connector

The standard connectors are 2-pin + 6-pin brass Subconn by MacArtney. Optional 8-pin + 6-pin if the

instrument is ordered with serial communication. There is the option to install the more robust

Souriau connector for long term on-line use.

Power requirements:

Internal battery: 

· Signature1000: 90 Wh, 3*10AA cells and 15VDC.

· Signature500: 180 Wh, 12 C cells and 18VDC.

· Signature250: 540Wh 18 V alkaline, or 1800Wh 19V Li.

External battery: Single or double alkaline 540Wh, or single or double lithium 1800Wh.

DC input: 12-48 (Sig500/1000), 15-48V (Sig250).

Note: Signature instruments cannot use Power over Ethernet (PoE) technology. Using PoE with your

Signature instrument will damage the electronics board and require repair.
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3 Getting Started
This chapter deals with installation of the accompanying software, connecting to the instrument and

other information that is important for first time use of the instrument.

3.1 Checking the Inventory

Check the contents of the received package against the packing list included in the shipment. Do not

hesitate to contact us if you find any part of the delivery missing.

3.2 Installing Software

The Nortek Deployment software is an important part of the Signature series and has been designed

to aid you in the planning, execution and recovery of your instrument deployment. A thorough

description of the software and its features can be found in the Operations manual. We recommend

that you update when prompted by the software to ensure that you have all the new functionality

accessible. To install the software:

· Microsoft Store version: Follow the link on our software page; this will open MS Store from where

you can install SignatureDeployment.

· Installer version: Find this version on the memory stick that came with the instrument, or

download it from our software page. This version includes dependencies that may need to be

installed prior to installing the .msix file. If you have difficulty installing this version even with the

dependencies, contact Nortek Support.

System requirements: 

Component Requirement

Processor 1 GHz or faster processor

Memory 1 GB RAM

Hard disk 100 MB (programs)

Operating system The software will run on Windows Vista or newer with .NET

framework 4.5. If you use Mac OS platform: you have to rely on

Windows-on-Mac virtualization programs such as Parallels

Desktop

Display 1024x576 or higher resolution monitor

Licenses: 

The Deployment software itself does not require a license to run. However, certain functions of the

Signature instrument are protected under different licenses, so register your licenses (refer to the

software help file for how to do this) in order to get the instrument to operate in a certain mode.

Register purchased licenses while connected to your instrument under Instrument > Licenses.

Licenses that are ordered with the instrument are already registered. You will not need a license

when updating the firmware version.

3.3 Connecting the Instrument to PC via Ethernet

The Ethernet communication has been implemented by using a dedicated network processor, and

needs to be powered by connecting a power supply to the external power breakout on the cable.

Note that powering through the Ethernet cable will also power the rest of the electronics.

mailto:support@nortekgroup.com
http://www.nortekgroup.com/software 
http://www.nortekgroup.com/software 
mailto:support@nortekgroup.com
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DO NOT APPLY POWER TO THE ETHERNET CABLE BEFORE YOU HAVE CONNECTED THE

CABLE TO THE INSTRUMENT

If you power the Ethernet cable before you connect it to the instrument, there is a risk that

you will connect the cable incorrectly and apply power to the wrong lines. This will cause

components on the board to burn out. If this occurs, you will see a loss of communication

and you will need to return the instrument to Nortek for repair.

1. Connect the supplied test cable to the communication output on your instrument, then apply

power to the breakout cable. The blue LED should be turned on shortly.

2. Use a direct connection or an Ethernet switch to connect the Ethernet connector to your

computer.

3. If you use a computer Ethernet port that has status lights, verify that the link is active by looking

for a solid green light on the port. If an Ethernet switch is used, the Ethernet port should also

show an active Ethernet link. If the status light is not lit refer to our Troubleshooting Guide.

Figure 3. Power distribution. When the Ethernet cable is connected to the instrument, it w ill need to be

powered from the power breakout cable. This w ill power both processor systems. If power is supplied

through the Serial or external battery connector, the Ethernet processor is unavailable.

3.4 Initial Ethernet Connection

The first time using the instrument, the network address needs to be properly configured for the

network. For new users who are unaware of how the network is set up, the instrument should be

plugged either directly into a computer (Ethernet cable) or via an Ethernet switch connected to the

computer. For more information consult the Appendix.

Remember that external power must be supplied to connect using the Ethernet interface. Ensure that

the correct cable is used to connect the instrument to the Ethernet port. Refer to the previous section

or the Troubleshooting Guide if the LED on the instrument, the PC port or the switch are not lit in the

correct manner.

1. Check the internet access status at the notification area in the taskbar of your PC. The

screenshot below shows that a local connection has been established (the IP address has been

set).
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 Figure 4. Local connection dialog box.

2. Open the Nortek Deployment software and click Connect to launch the Discovery feature (figure

5). This will produce a window with a list of instruments available on the network. It may take a

few minutes before the Discovery tool lists a newly connected instrument. This is due to the IP

address assignment process (more details are available in Appendix). If the instrument is not

shown in the list, wait approximately 90 seconds and click Discover again. The computer is

capable of communicating with the instruments shown with a white background in the list. If an

instrument in the list has a red background, it is not possible to connect to it (see section

Software Problem). 

3. Select the instrument by finding the Serial number that matches your instrument and click

Connect. With multiple instruments, assigning a suitable nickname for identification purposes

should be useful. This can be found under Instrument > Nickname once you are connected.

Figure 5. Discovery dialog
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3.5 Serial communications

The Signatures can be purchased with both Ethernet and Serial communications. When connecting

with serial, the only way to communicate with the Signature is through a terminal. The terminal in the

SignatureDeployment software can be used, but no other part of the GUI will be available when

connected over serial. Therefore any streamed data will only be available at binary or ASCII text.

For information on how to control the Signature instruments over a serial connection, please read the

Signature Integrators Guide.

4 Preparation
From this point on it is assumed that a stable, reliable connection with the instrument has been

established. This is necessary to continue onwards for the next few sections of the manual. If the

instrument is unable to connect with your PC please revisit the Getting Started chapter or consult the

Troubleshooting chapter.

ALWAYS ENSURE YOUR SIGNATURE HAS THE LATEST FIRMWARE

Nortek releases firmware updates multiple times per year. We are constantly improving

Signature functionality and components, so it is extremely important that the firmware on

your instrument is kept up-to-date. Failing to keep the firmware updated may mean that

your instrument will not work as intended.

Updating the firmware will not affect your installed licenses.

When you connect to a Signature, the SignatureDeployment software will prompt you to

update the firmware if a new version is available (when connected to the internet). You can

also check the Software page for updates. See this chapter for instructions.

4.1 Functionality Test

Before any sort of deployment test it is strongly recommended to undergo a functionality test to

ensure that the various components are working as intended. Before continuing make sure that your

instrument is connected as described in Initial Ethernet Connection. The Functionality Test

procedure also assumes that you are familiar with the Deployment Software as described in the

Deployment Wizard section.

First we need to create a .deploy file which preferably samples at the maximum rate. To do so select

all the default options except Average interval and Measurement interval which should be set to the

lowest common value.

Once connected, select Online > Start Data Collection, and select the .deploy file we just created

which will start real time sampling. An easy way to tell if the instrument is sampling is to check the

LED which will blink every time a ping is sent by the instrument. 

Once the instrument is sampling you will find information regarding the various sensors in the main

screen, refer to Online Data Collection for more information.

First check that your firmware version is up to date with the Nortek software page. When you

purchase a brand new instrument, it has a firmware version matching the PC software, hence no

https://support.nortekgroup.com/hc/en-us/articles/360029513952-Integrators-Guide-Signature
http://www.nortekgroup.com/software
http://www.nortekgroup.com/software
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firmware upgrade will be needed before you start using the instrument. However, new functionality

(and bug fixes) is likely to be offered in the future, requiring that the firmware be updated. New

firmware is posted on the Nortek software page. Download the version corresponding to your

instrument type. Click Instrument > Firmware Upgrade and follow the on-screen instructions. You

must reformat and reboot the instrument after every firmware upgrade.

Note: If you leave the instrument collecting data using the internal batteries it will run until depletion.

Always make sure to stop data collection when testing is complete.

Temperature

To test the temperature sensor simply read off the corresponding value and compare with your room

temperature.

Pressure

The pressure sensor outputs the absolute pressure value in units of dBar. During production, the

sensor is adjusted to 9.5 dBar to output the gauge pressure (pressure relative to the atmospheric

pressure). The pressure sensor cannot output negative values. The outcome is that when the

instrument is in air, you will see a value of 0.2-0.7 dBar, depending on atmospheric conditions. 

Test the pressure sensor by submerging the instrument in approximately 0.5 m of water. The value

should read 0.5 dBar + the ambient pressure of 0.2-0.7.

An alternative way to test whether the sensor is functioning is by forming a seal around the sensor

with your mouth and blowing to observe an increase in pressure.

Tilt

1. Find the X mark located on the instrument and identify which direction it is pointing.

2. Hold the instrument as level as possible while aiming the X direction away from you. The values

for "Pitch" and "Roll" should now be close to zero. 

3. Tilt the instrument 10º to the right. The "Roll" value should read approximately 10.

4. Tilt the instrument 10º to the left. The "Roll" value should read approximately -10.

5. Tilt the instrument 10º forwards. The "Pitch" value should read approximately -10.

6. Tilt the instrument 10º backwards. The "Pitch" value should read approximately 10.

7. Now turn the instrument upside-down, still aiming the X direction away from you. Repeat steps 2 -

6 and ensure you have the same values. Note that an AHRS-enabled instrument will read 180°

when upside-down.

Note: While holding the instrument upside-down the Accelerometer Z value should read -1.

http://www.nortekgroup.com/software
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Figure 6. Definitions of beam number, pitch and roll

Compass

Point the X-direction towards North. Rotate the instrument around the Z-axis and check the values at

0, 90, 180, 270 degrees corresponding to North, East, South and West respectively. 

Electromagnetic interference from magnets, metals, etc in the vicinity can interfere with the

measurement so take this into consideration when evaluating the result. Check the Compass

Calibration section for more information.

Amplitude

Each beam measures amplitude in dB and should be checked individually. Do this by shooting one

beam at a time into water (or a water filled bag as in picture below), you should see a peak in

amplitude corresponding to the individual beam number you are testing. The beams are numbered 1-

4 starting with the beam facing the X-direction and going clockwise with the fifth beam in the center.

Remember that you will need a license that covers fifth beam operation to test its functionality. The

data from the fifth beam can be found in the raw data.
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Figure 7. Example of an amplitude test. Covering one beam at a time with a water

filled glove.

Check and record the noise floor (amplitude) for the instrument in air. Values should be between 20

and 30 dB, this will vary with bandwidth and frequency used. Submerge the sensor head and check

the maximum amplitude, values should increase significantly. Since the instrument relies on

scattering particles, clean water will give low returned signal strength. The purpose of the test is to

see that the returned signal has a significant increase in strength relative to the noise floor. All the

beams should have approximately the same values.

Note: Background noise is very prone to interference from nearby sources, such as a power supply.

During testing make sure the instrument is far enough away from other electronics. 

Correlation

Correlation values should be observed before the transducers are submerged in water and compared

to the values while underwater. You should notice a significant increase.

Recorder/Memory

1. Test the recorder by selecting Deployment > Start Recorder Deployment.

2. Name the file "test" and start deployment. A notification may appear warning the instrument is

running off an external power supply, press Yes to continue. 

3. A popup confirming your deployment will appear, press OK. You will be taken back to the Home

screen while the instrument is deployed. 

4. After a few minutes, stop the data collection by reconnecting to your instrument.

5. Find the "test.ad2cp" file you created under Deployment > Recorder Data Retrieval and press

the  icon.

6. Select Deployment > Data Conversion and find your downloaded "test.ad2cp" file using the

Add file feature. Specify the folder you want to save the converted Matlab file in and press Start.

Note: If you leave the instrument collecting data using the internal batteries it will run until depletion.

Always make sure to stop data collection when testing is complete.

Note: We recommend starting new deployments with an empty memory. Before you erase the

recorder, make sure that you have transferred all the data you want to retain. Click Deployment >

Recorder Data Retrieval and Erase Recorder. 
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4.2 Changing Batteries

The internal battery pack is located inside the housing. Note that the instruments are shipped with

the battery disconnected. 

You can estimate the power consumption before the deployment using the planning module in the

Deployment Software. We encourage using new batteries for each deployment. 

To connect the battery pack for the first time or to replace it with a new one, follow the guidelines

below.

Remove any existing connections from the instrument. Place the instrument

with the end cap facing up and remove the four bolts using the provided tool

(see toolkit). Take a second to note how the end cap is matched with the

housing (refer to image). The positive X-axis points in the direction of the

labels. 

If the lid is stuck, use the supplied tools (see picture) and place them in a

notch on each side of the canister. Twist in opposite directions to loosen the

lid then slowly lift up the end cap.

Disconnect the 3-pin (or 9-pin if serial communication) and 9-pin cables from

the end cap. It may be necessary to have another person holding the end cap

while disconnecting. Set the end cap aside and make sure not to scrape,

damage or lose the O-rings. Remove the old batteries and slide the new

battery pack carefully into the housing, making sure to thread the cables

through the hole (see picture). Connect the battery harness (female) to the

two 2-pin connector (male). 

Connect the 3- or 9-pin connector (female) to the end cap (male), to enable

the use of an external battery canister. 

Connect the 9-pin to the end cap and check that the grounding cable

(green/yellow) is fastened.

Check the O-rings on the end cap are maintained as per described in the O-

ring Care section. This is perhaps the most crucial step as it ensures the

instrument does not leak in water. 

Make sure the end cap is oriented correctly as you put it back in place. Take

special note that none of the wires are squeezed when placing the end cap.

Loosely cross tighten each screw before tightening properly. Refer to the

Securing Screws section for more detailed information. Note the washer and

lock-washer sequence.

Note: You will need to do a new compass calibration after changing your battery as the magnetic

interference will be different from before. 
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Note: The Signature500 alkaline battery pack holds 12 C cells and gives a nominal starting voltage of

18 VDC. The Signature1000 has 3*10AA cells and gives a nominal starting voltage of 15 V. The

Signature250 alkaline battery pack gives a nominal starting voltage of 18 VDC. The voltage of alkaline

cells falls quickly at the beginning, slowly during most of its life, then again quickly at the end.

When is the battery pack considered dead, you may ask. We do not have a clear cut answer,

because the measured voltage of the battery will vary greatly depending whether a load is applied or if

you measure just using a voltmeter. The internal Signature500 18 V batteries should be considered

"empty/used" below 17 V and completely dead at 12 V if using a voltmeter. For the Signature1000,

the corresponding numbers are 15 V, 14 V and ~12 V. The instruments will be able to measure < 12

V when a load is applied. The best way to estimate how much is left of the battery is to use the

estimates given by the Deployment Software. For example: The internal Signature500 batteries are

180 Wh. With a configuration setup that uses approx 0.7 Wh per day, and a total run time ~126 days

will lead to ~88 Wh used with ~90 Wh remaining.

External Battery Canister

The following procedure outlines how to connect the external battery pack or install a new one.

Remove the three screws and washers holding the end cap to the pressure

case, and remove the end cap.

Disconnect the 2-pin connector and pull the old battery out of the pressure

case.

Slide in a new battery and connect the connectors.

Check the O-rings are maintained as per described in the O-ring Care section.

Place the end cap and mount the three screws and washers.

Test the instrument by collecting data without using an external power source to

ensure that the battery is properly connected. Make sure to stop data collection

so that the instrument will power down after the testing is finished.

Note: Make sure to always include a desiccant bag in the housing and canister. Humid air can

condense enough water to cause damage. 

Check and follow local regulations about proper disposal of batteries (alkaline or lithium) as this

varies between countries.
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4.3 Guide rail harness removal

This section is relevant for Signatures with long housings that will be powered by Lithium batteries.

With the Lithium batteries there is not enough room in the housing with the standard guide rail

installed, so the solution is to remove it. The following describes the procedure.

Figure 8: 1: Housing, 2: Set

screws, 3: Rail, 4: Bracket,

5: Screws

Open the battery compartment as described in the previous section

Remove the two screws (5) that fix the bracket (4) to the housing (1). (The

numbering refers to the figure above) 

Remove the bracket, and carefully slide the guide rail harness (3) out. It is

fixed to the base plate with set screws (2) so it should not be difficult to pull it

out.

The rail is secured with an extra set of screws and washers

Connect the battery. Follow the guidelines in the previous section for details

If the harness should still be secured to the side, the rail can be replaced by a piece of duct tape to

make the installation of a new battery a bit easier.
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4.4 Compass Calibration

The steps below applies both to instruments with a standard magnetometer and to those with the

AHRS option.

1. Assemble the frame/buoy with the instrument, battery canister, extra ballast, etc. so as to

simulate the intended deployment setup as closely as possible.

2. Connect the system to the computer. Click Instrument > Compass Calibration.

3. Be prepared to rotate the entire system slowly around the Z axis of the instrument. Click Start.

Note that when doing this in the field, you cannot expect to produce a perfect circle. However, we

recommend you to do this slowly, approximately 30 seconds per 360º, in an attempt to come as

close to the ideal circle as possible.

4. After full rotation click Stop. If the data collected is suitable for calibration, the Quality indicator

turns green. Yellow indicates an adequate calibration and red indicates a bad calibration. A good

calibration will have a relatively flat Corrected Normals graph.

5. To use the obtained values, click Update. You will be prompted to confirm that the offset values

shall be transferred to the instrument to serve as the new compass setting.

Figure 9. 2D Compass calibration dialog box

Typically you will see offsets coming from these two sources:

Hard Iron (X/Y offset): This will cause a shift in the position of the ellipse away from the origin (0,0).

Soft Iron (Mx, My, Mz): This will deform the ellipse.

After the instrument offsets have been updated the calibration can be verified be re-executing the data

collection and rotation and ensuring that the circle produced is centered on (0, 0, 0) (and that the

corresponding offset corrections are close to 0). This will verify that the hard and soft iron influences

have been compensated for. 

Ticking "Record data" will write the compass calibration values to a .txt file in the C:\...

\Documents\Nortek\Deployment\Online folder, e.g. CompCalib_20210604T094001.txt). You can then

use this file to apply the same calibration to the same or another instrument using "Load data file".
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Note: Be aware of any material that may be disrupting the magnetic field in the vicinity during

calibration as this may skew the directionality of your data. This is likely to occur at magnetic fields

stronger than 5 Gauss. Velocities with respect to X, Y and Z and according to each beam will be

correct but North, East and Up may be incorrect. If possible, do the final calibration before you board

your vessel as ship decks tend to have non-uniform magnetic disturbances significant enough to

disrupt the compass calibration process.

 

Note: Do not subject any part of the instrument, including batteries, to a magnetic field stronger than

20 Gauss. This may permanently damage the components and cause irreversible damage to the

compass.

The raw data from the magnetometer and accelerometer are stored every time the compass direction

is read. From a practical point of view this means that any instrument that has spun 360 degrees

during a deployment can be calibrated for hard iron effects in post processing so long as you have

the Ocean Contour software. This avoids the problem of calibrating the compass before deployment

and in principle makes it possible to achieve higher directional accuracy in the current velocity data.

Magnetic Declination

The compass calibration does not correct for magnetic declination at the deployment site. This must

be added either before the deployment using commands (see the Integrators Guide), or after the

deployment when post-processing in Ocean Contour.

4.5 Before Deployment

With the previous sections of this chapter successfully completed you are now ready for your final

preparations before deployment. 

· We recommend that you carefully plan the deployment setup and make yourself aware of the

possibilities in the Nortek Deployment software. Simply select Planning > Deployment

Planning to open the deployment settings. Here you are able to configure the settings without

needing a live connection with your instrument. Set the deployment configuration as desired and

click Save configuration. This will allow you to quickly load the settings onto multiple

instruments and keep equivalent deployment settings time after time. 

· For stand alone systems, it is vital to remember to connect the dummy plug to ensure the

instrument is water tight. Before mating, ensure that the connectors are dry and free of debris, look

for water inside the female connector. 

· When properly mated,  the engaging nut on the cable plug will thread smoothly onto the receptacle

shell until it rather abruptly reaches a point where it cannot be hand-tightened any further. At this

point the mating surfaces of the plug and receptacle are in contact, and have formed a good seal.

The amount of force required to tighten the engaging nut should stay the same throughout (up until

the point where it cannot be further hand-tightened). Otherwise, the connectors are not mating

properly and will not form a good seal.

· Set a pressure offset. The instrument measures absolute pressure, and the pressure offset

selected is the pressure reading for offsetting absolute to relative pressure. The factory setting is

9.5 dBar; this is chosen so that you always see a non-zero reading when the instrument is in air

and can verify that the pressure sensor is functioning correctly. For reference, atmospheric

pressure usually fluctuates around 10.13 dBar, and 1 dBar is equivalent to the pressure change

over 1m depth in fresh water (so at 1m depth the absolute pressure would be 11.13 dBar).

http://www.nortekgroup.com/software
https://support.nortekgroup.com/hc/en-us/articles/360029513952-Integrators-Guide-Signature
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· We recommend starting new deployments with an empty memory. Before you erase the recorder,

make sure that you have transferred all the data you want to retain. Click Deployment >

Recorder Data Retrieval > Erase Recorder. If the SD-card becomes full during deployment, the

data will stop being written/saved. But it will continue to measure in case serial output is turned on.

· Depending on when you set your deployment start time it can be wise to check that the instrument

has started sampling as planned. This can be done by checking the LED which will blink every

time a ping is sent by the instrument.

· Be aware that if the deployment time has passed when the battery is connected, the instrument

will resynchronize its data sampling according to the deployment time and the instrument

configuration. This means you may have to wait for one average measurement interval or one burst

measurement interval before the instrument starts to ping. When the instrument re-synchronizes, it

will blink the LED once just after the battery is connected.

Example: the deployment is set to start at 12:00 with 20 minute measurements intervals, but the

battery is connected at 12:10, the first measurement interval will start at 12:20. 

· If you are using an internal and external battery the primary battery will be selected based on

which has highest voltage.

· We recommend starting a deployment with fresh batteries. But if you want to estimate how much

is left of a used battery the best way is to use the estimates given by the Deployment Software.

For example: The internal batteries for the Signature500 are 180Wh. The last deployment lasted for

126 days and were using approximately 0.7Wh per day (this information can be found in the saved

.deploy file). Then the remaining Wh of the battery is thus 180-88 ~ 90Wh

· O-rings for the online connectors should be lubricated with silicone lubricant.

It is worth double checking your deployment settings and the structural integrity of your rig before

deploying the instrument. 
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5 Software
The Deployment software has been designed to aid you in the planning, execution, recovery, retrieval

and conversion of data collected. In addition to the information below, a description of the various

elements on the screen (parameters, buttons etc.) will appear if you hover over the element in

question (mouse-over-text).

The newest Deployment Software version is always available for download from our website; check

out the Installing Software section for more details.

5.1 Discovery Tool

The Discover configuration menu selection provides a means to locate and configure the network

information for instruments without having to know the IP address of the instrument. All instruments

found on the network are displayed. 

· Highlight the instrument you want to connect to and double-click/use the Connect button. 

· If you use a static IP address you can type it directly into the Discovery dialog and click Connect. 

· If you connect to the instrument using serial cable, check the "Serial Port" box, select the correct

communication port and baud rate. The default is 9600. Note that the latter will let you

communicate with the instrument through the terminal window only.

Note that it may not be possible to "discover" instruments on networks that are connected to the

local network through a router. Read more about this in the Troubleshooting chapter.

Figure 10. Discovery dialog box

· Instruments shown in the list that have a gray background will be possible to connect to. 

· Only one person can be connected to an instrument at a time. If you try to establish connection

with an occupied instrument, you will receive a notification. 

http://www.nortekgroup.com/software
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· If an instrument has a red background, a notification box will give you information regarding the

error. Refer to Software Problem chapter for information. 

Right-click the highlighted instrument to get the option of using the Terminal Emulator (or press

Ctrl+T, consult Appendix if needed). In the menu you also have the possibility to open the instrument

specific web site or show the instrument logs (Deployment log, Instrument log, System log and SEC

[Serial Ethernet Connectivity] log). There is also an alternative called "Network Configuration", which

enables the possibility to enable/disable DHCP or set the IP address. The latter option is described

in detail here.

5.2 Deployment Wizard

The instrument is configured by clicking the Plan button or clicking Planning > Deployment

planning in the menu line. The Deployment Planning is structured as a wizard which guides you

through the necessary steps to configure the instrument successfully. It is possible to configure the

settings for your deployment file without a live connection with your instrument.

The Deployment Wizard view is divided into three parts; Steps, Instrument and Effect (refer to

screenshot below). The idea is that you follow the steps using the Next button (and Back, if you

need to) and make the adjustments from the default options. The first three steps; Instrument,

Application and Environment define the physical settings of the instrument. The remaining steps

determine how and when the instrument measures. When you change the settings in one step, the

default values in the following steps will also be adjusted. 

The Effect field displays performance parameters that are automatically updated as you change the

parameter settings. It is a good idea to keep an eye on the Effect during the planning, to make sure

you do not violate any limits e.g. required precision of the data, power consumption or memory

available. Parameters that are highlighted in yellow are meant to serve as notifications and warnings

to the user. An explanatory tooltip will be displayed if the mouse is hovered over the parameter.

The planning will result in a Deployment file (.deploy). The instrument can be started directly from the

Deployment Wizard (if you are connected to an instrument) by using Deploy or Start Online

buttons. The .deploy file can be saved and then uploaded to the instrument before deployment, and

this option will allow you to quickly load the settings onto multiple instruments and keep equivalent

deployment settings time after time. The Customize option lets you save the file and open it in a text

editor for further customization.
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Figure 11. Deployment planning, step 1. Overview of the instruments and licenses.

Before going into the details of each step, here is an overview of the different parts of the Effect and

Summary tabs. 

Effect

Performance

Configured length

(days)

Number of days you would like to collect data. This value, together with the

other deployment parameters and the hardware configuration, will be used for

calculating the performance parameters, i.e. power usage, recorder memory

requirements and velocity precision.

Estimated max

length (days)

The deployment duration based on measurement parameters, hardware

configuration and configured number of days.

Battery capacity

(Wh)

Total watt-hours as determined by the user.

Power usage (Wh) The estimated power requirements as calculated by the firmware.

Recorder capacity

(MB)

If no instrument connected; total capacity of the recorder in MB.

Recorder free

space (MB)

If instrument connected; unused space on the recorder in MB.

Memory usage

(MB)

The estimated memory requirements as calculated by the firmware.

Data sampling

Power level (dB): Relative dB scale, where maximum power level is 0 dB. The maximum allowed

power level varies with the configured profile range.

Long range mode On or Off, varies with user requirements for range. In long range mode, more

pings are required to reach the same velocity precision.

Multiplexing Only applicable for Signature250/100/55. Threshold at -6dB for on/off
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Number of pings The number of pings to be averaged together during the averaging interval.

Important for velocity precision.

Slanted/vertical beams

Horizontal prec.

(cm/s)

A theoretical estimate of the precision of the velocity measurements based on

how the instrument is set up. As a rule of thumb, this should be lower than

1/10 of the expected velocities in the measurement area.

Vertical prec.

(cm/s)

A theoretical estimate of the precision of the velocity measurements based on

how the instrument is set up.

Velocity range

(m/s)

Maximum along-beam measurable velocity. Velocity range should cover the

range of the velocities anticipated during the deployment. A velocity range set

too high may result in more noisy data, and too low will mean that you will not

be able to measure the highest velocities. If a range is set too short, it will

result in velocity wrapping. This is based on the selected mounting method.

Measurement range

Desired range (m) Calculated based on instrument depth, up/down orientation and end of profile.

Configured range

(m)

Calculated based on end of profile and cell size.

Estimated range

(m)

Theoretical estimate. Based on "Geography", end of profile, cell size, power

level and long range mode.

Blanking distance

(m)

Blanking is the time during which no measurements take place, to give the

transducers time to settle before the transmitted signal returns to the receiver.

This blanking reduce the interference from ringing based on the selected "Start

of profile (m)"

Cell size (m) Specifies the vertical length of each depth cell in the profile. Standard deviation

of the velocity measurements is inversely proportional to the depth cell size

(larger depth cells give smaller standard deviations).

Number of cells Number of depth cells to collect per profile. The maximum number of depth

cells with accurate velocity data will vary with system frequency, depth cell

size and deployment conditions

Number of beams Number of active beams with selected configuration.

Altimeter Vertical distance measurement On/Off

Ice drift Tracking of ice on/off. 

Pulse distance Related to HR settings. See below.

Altimeter start (m) Altimeter start of measurement distance

Altimeter end (m) Altimeter end of measurement distance

Sampling rate

Measurement

interval

Describes how often the instrument will collect data. 

Configured

average interval

Specifies how long the instrument will be actively collecting data within each

Measurement interval

Actual average

interval

Specifies how long the instrument will be collecting data within each

Measurement interval. Differs from the Average Interval to allocate the Number

of Pings correctly within it.

Sampling rate (Hz) Number of samples to collect per second.

#Samples Number of samples to collect each burst interval

Burst duration (s) The duration of one burst, defined by #Samples/Sampling Rate.
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Summary presents a summary of the deployment based on the selections made.  Some

parameters are presented in the previous table.

Performance

Min configured baud

rate

The minimum required baud rate, based on the amount of data being

transferred (in turn based on measurement plan, number of cells, etc.)

Max RS422 cable

distance (m)

The maximum length of an RS422 cable that can be used, based on the

configured baud range

System information

Instrument name Type of instrument, e.g. Signature1000

Nickname The identifier given to this particular instrument

Serial number The serial number of the instrument

Head frequency (Hz) The frequency of the transducers on the head

Opt. sensors Any additional sensors that have been added, e.g. AHRS

Firmware version The currently installed firmware version

Recorder size (GB) The size of the installed and licensed recorder

Connection If Ethernet: IP address of instrument. If Serial: connected COM port.

Orientation How the instrument is determining its orientation, e.g. Auto Z up/down

Application (see below for definitions)

Environment (see below for definitions)

[chosen measurement regime] (see below for definitions)

Step 1. Instrument. Refer to screenshot above.

· Select the type of instrument that shall be used. If the Signature is connected, that will be the only

alternative available. Licensed features available for this particular instrument will be listed, the

same applies to the Recorder.

· Licenses: Available functions. Contact Nortek if your measurements require other licenses.

· Recorder Capacity: Lists the recorder options.

· Sensors: AHRS (Attitude, Heading, Reference Sensor - requires additional hardware). Enable if the

instrument is to be deployed in a dynamic environment. 

· Deployment length (days): Enter the number of days you would like to collect data. This value,

together with the other deployment parameters and the hardware configuration, will be used for

calculating the performance parameters, i.e. battery utilization and recorder memory requirements.

· Specify the type of battery used (does not apply for online deployments). This is used to calculate

power usage.

Step 2. Application. Select between Single and Concurrent plans. For the Signature500 and

Signature1000 Alternating plans are also enabled. Check out the Appendix for a short overview of

each application.
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Figure 12. Deployment planning, step 2. Choose application.

 

· Single plan means that the instrument will measure selected sampling application at the defined

measurement intervals.

· Concurrent plans enable different sampling schemes at the same time. The measurement duration

and interval of concurrent plan no. 1 can be specified without taking much consideration of the

second plan. See sketch below showing an example of a measurement sequence. The

measurement interval and sampling rates are specified under step 4 and 5.

Figure 13. Visualization of a concurrent plan deployment setup, where the instrument samples bursts

and profiles concurrently

· Alternating plans enables the possibility of alternating the sampling regime during deployment at a

specified ratio. See example of measurement sequence below.
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Figure 14. Visualization of an alternating plan deployment setup. The instrument alternates between

measuring Current Profile & Burst and Current Profile & Waves, at a ratio of 2:1.

Step 3. Environment. 

· Sound Velocity; Speed of sound can be set by the user (Fixed) or calculated by the instrument

based on the measured temperature and a user-input value for salinity. The salinity is 0 for fresh

water and typically 35 for the ocean. The instrument uses the speed of sound at the depth of the

transducer to scale the Doppler frequency shift to velocity.

· Deployment: Specify if the instrument is looking upward or downward during the deployment, and

estimate the distance to the bottom/surface. If the surface or the bottom is within the range of the

instrument, this distance is used to configure the profiling range.

· Mounting: Choose the settings that best fits your deployment, which affects the velocity range.

· Geography: Choose the settings that best fits your deployment. This selection suggests a suitable

power level and the long range mode for current profiling.

· Wave Climate: Check if strong waves are to be expected which affects the velocity range. Also

specify the expected tidal range which helps configure the number of cells in the next step.

Velocity range: The velocity range reported by the Deployment software is the along-beam velocity

range, which translates to a horizontal velocity range of VR/sin(θ), where VR is the reported along-

beam velocity range and θ is the beam slant angle. For example, a Signature1000 with a VR of ±5

m/s and a slant angle of 25° will have a horizontal velocity range of ±11.83 m/s.
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Figure 15. Deployment planning, step 3. 

Next steps (depends on Application)

Average 

· Range:

o The instrument measurement region starts at Start of Profile (meter from the transducer) and

ends at End of Profile. The Start of Profile defines the blanking distance

o Cell size is the vertical size of the individual cells in the profile, in meters. A larger cell size will

make the instrument transmit more energy for a given power level. 

o Power level should be set to match the desired Estimated max range or exceed it with a desired

margin. 

· Sampling: 

o Averaging interval specifies how long the instrument will be actively collecting data within each

Measurement interval. Example: Measurement Interval is set to 600 seconds, averaging interval

set to 60 seconds means that the instrument will collect data for 1 minute every 10 minutes.

Averaging Interval must be smaller than or equal to Measurement Interval.

o Measurement load: Within each second, the instrument can either be in active mode (collecting

data) or in idle mode (not collecting data). The Measurement load is the relative time spent in

active mode within each second and can have value from minimum (one ping) to 100% (always

in active mode). With the Auto option selected, the program will automatically calculate an

appropriate measurement load based on the averaging interval and the corresponding horizontal

precision. Measurement load should be used as a configurable trade-off between precision and

battery usage.

· Options: Select a coordinate system as desired. Changing the coordinate system can always be

done in post-processing. Telemetry data format determines if serial output is enabled and which

data format is used. Consult our System Integrator's Guide for more details about the Telemetry

file. Enable serial output if you want the data out on the Ethernet or serial port.
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Figure 16. Deployment planning, step 4. Configure measurement regime.

Burst: similar settings as Average, except:

· Sampling: 

o Measurement interval determines how often the measurement scheme cycle should restart. 

o #samples: Number of samples to be taken within the measurement interval. 

o Sampling rate: Number of samples per second. 

o Measurement load: Within each second, the instrument can either be in active mode (collecting

data) or in idle mode (not collecting data). The Measurement load is the relative time spent in

active mode within each second and can have value from minimum (one ping) to 100% (always

in active mode). With the Auto option selected, the program will automatically calculate an

appropriate measurement load based on the averaging interval. Measurement load should be

used a configurable trade-off between precision and battery usage.
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Figure 17. Deployment planning, step 4.

HR: Relevant for Signature1000 with High Resolution (HR) license. Similar settings as Average,

except:

o Lag beam 5 (m): Time between two transmit pulses. The profiling range cannot exceed the time

between the pulses, which means there is a coupling between the profiling range and the max/min

velocity that can be measured. The resulting velocity range is reported under effects. When looking

up towards the surface the lag should be set to half the distance to the surface to account for

waves. When looking down towards the bottom the lag should be set to the distance to bottom. In

open water, the lag can be increased as long as the velocity range is sufficiently high.

Waves, Waves and Burst: similar settings as Burst.

o Range; Power level: Specifies how much acoustic energy the instrument transmits into the water.

If disabled, the configuration uses the same power level as for the current profile.



Signature Series Operations Manual32

Nortek AS

Figure 18. Deployment planning, step 4.

Ice draft (keel): Relevant for Signature250 and Signature500

o The altimeter measurement region starts at Altimeter start (meter from the transducer) and ends at

Altimeter end. 

o Measurement interval: how often a single ice thickness measurement will be done. 

o Store echo data: how often raw altimeter data will be stored (in increments of measurement

interval). 

Echo Sounder: Relevant for Signature 500 and Signature1000

· Range

o The measurement region starts at Start of Profile (meter from the transducer) and ends at End of

Profile. The Start of Profile defines the blanking distance

o Cell size is the vertical size of the individual cells in the profile, in meters. A larger cell size will

make the instrument transmit more energy for a given power level. 

· Echogram

o Echogram can be combined so that the instrument measures both with and without pulse

compression, or with different strength on the transmit pulse (transmit length). It is possible to

enable three Echograms, but only one of them may be using Pulse compression. If unsure about

what to select, it can often be a good idea to enable one echogram without pulse compression

and another echogram with pulse compression enabled. Then you get both results at the same

time and can decide later which one to use.

o Transmit length with pulse compression: With pulse compression enabled, the center transducer

transmit a sound wave (pulse) with a bandwidth of 25% (compared to the normal 6.25%).

Changing the transmit pulse length when using pulse compression can increase the SNR at the

expense of the power consumption. The resolution is not affected as the cell size will be equal to

the configured value. Note that pulse compression may in some circumstances suffer from

sidelobe effects but generally, this is not a problem.

Without pulse compression: The length of return echo will be a convolution of the rectangular

transmit pulse and receive window. If the transmit pulse length is set to cell size/(c/2) or
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nominally cell size/750, the cells will consist of triangularly weighted echoes, similar to the

classical ADCP cells. In this case the resolution depends on both the length of the transmit

pulse and the cell size. The best resolution is achieved with the shortest allowable transmit

pulse but still limited by the bandwidth which corresponds to a resolution of 12 mm for the

Signature1000 and 24 mm for the Signature500.

· Store Raw Echo Data (under the Burst tab)

o "Store raw data" enables the storage of the demodulated in-phase and quadrature components

of the echosounder signal. These data are used when calculating the echograms output by the

instrument and enable replication of the instrument algorithms in post-processing as well as

implementation of other processing schemes. They can be very useful during echosounder

calibration since they can be used for very precise distance estimates to calibration spheres.

Figure 19. Deployment planning, step 4.

Final step: Deployment

When you are finished with the wizard, the configuration you have prepared must be saved as a

deployment file. Define a name for the Deployment file you have prepared and add comments. The

File menu configures where and how data are to be saved to the disk. The default filename is as

follows: AD2CP_Instrumentfrequency_serialNO_DeploymentName.deploy.
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5.3 Stand-Alone Deployment

A deployment sequence is started by clicking the Deploy button, and you will be prompted to select

which deployment file to use. This activates a summary of the configuration:

Figure 20. Deployment summary. The

highligh presents relevant information

· Read through and verify that the set-up is as intended. This dialog box will confirm the selections

made in the Deployment Wizard.
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· The Deployment Name is by default the same as set in the final step of the Deployment Wizard,

but it is possible to rename it. 

· If you want the deployment to start some time in the future, set the date and time in the

Deployment time field. 

· The synchronize clock to PC time sets the instrument clock to the same as the PC clock. The

purpose is to set the time as correctly as possible. The time reference is especially important in

order to ensure proper synchronization between the instrument and other data sets collected

independently. Time spent to properly set the time before a deployment can save a lot of time in

post processing and analysis.

· The LED can be set to blink for every sample (On), blink for the first 24 hours of deployment (On for

24h), or never (Off).

· Press Deploy to send the configuration to the instrument. 

The instrument connection will be closed during data collection, and you will be sent back to the

Disconnected View of the software. The instrument is now properly configured and will stay in sleep

mode until it begins its deployment at the scheduled time.

To stop the deployment, click Connect. Find the instrument in the Discovery feature and click the

instrument you want to connect to. A notification will warn you that connecting to the instrument will

stop data collection.

Be aware that if the deployment time has passed when the battery is connected, the instrument will

resynchronize its data sampling according to the deployment time and the instrument configuration.

This means you may have to wait for one average measurement interval or one burst measurement

interval before the instrument starts to ping. When the instrument re-synchronizes, it will blink the

LED once just after the battery is connected.

Example: the deployment is set to start at 12:00 with 20 minute measurements intervals, but the

battery is connected at 12:10, the first measurement interval will start at 12:20. 
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5.4 Online Data Collection

An online measurement sequence is started by clicking the Start button, and you will be prompted

to select which deployment file to use. Data collection will start immediately after the selected

deploy file has been opened. After data collection has started, the Stop data collection is enabled.

If you want to record the online data, make sure to select Record Data under the Online menu

before clicking Start. Otherwise, data are not saved on the recorder nor the computer hard drive

during data collection. To find the data recorded to disk, click File > Open Online Data Folder.

The online data collection functionality in the SignatureDeployment software is intended mainly for

function testing. For long-term deployments with real-time data output, enable data telemetry over the

communications line using commands (see the Signature Integrator's Guide).

The online display window shows profiling and time series graphs for data currently collected by the

instrument. Refer to screenshot below. The main display consists of two resizeable panes. The top

pane contains multiple tabular listings of measurement and status data. The bottom pane contains

multiple chart and sweep plots of the measurement data. Different display groups are divided into

tabbed windows to provide better viewing of the data. Use the time series row to select which data to

display; either showing one cell at a time or a profile of one of the beams at a time. Certain data

elements are displayed in a text pane. This displayed data is picked up live from the data stream as

it is being collected (so no changes will be seen in this pane unless data collection is proceeding). 

Figure 21. Overview of the main screen. This screenshot is from a Signature1000 in air.

https://support.nortekgroup.com/hc/en-us/articles/360029513952-Integrators-Guide-Signature
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5.5 Recorder Data Retrieval

The Data Retrieval dialog box shows a list of all files currently stored in the recorder, including the

time of the first measurement and the size for each file. The .cfg is the configuration file, the .ad2cp

contain all raw data, stored in binary format. To allow the user to quickly investigate the results

without having to download the full raw data file ([filename].ad2cp), an additional data file is stored

containing only the averaged current data ([filename]_avgd.ad2cp). Only data where the correlation is

above 50% will be included in the averaging, and the data will also include a percent-good value. Any

bad data will be removed, or flagged with extreme values (e.g. -32.77 m/s). This averaging is only

applicable to average mode; burst data will not be processed in this manner. "Percent Good" is

defined as the percentage of data points above 50% correlation that go into an average ensemble.

Click the magnifying glass to see a summary of the deployment. Then download either all data (white

arrow), or just the internally averaged data (_avgd.ad2cp file, dark gray arrow). The raw data

downloads all single ping data. The file will be saved by default in the folder named

Users\User\Documents\Nortek\Deployment\Downloads, but this can be changed if needed. Multiple

files can be downloaded at the same time. The "Show all" check box can be checked off if you want

to see all files available on the recorder.

The firmware splits each deployment into 1 GB files, which are merged together when you download

them. The "Download All" button will retrieve everything from the recorder but will not merge the files.

You will need to use the white or gray arrows. It is not possible to change the maximum file size.

Erase Recorder

Click Deployment > Recorder Data Retrieval > Erase Recorder. It is good routine to do this in

advance of every deployment as we recommend starting new deployments with an empty memory.

Erase Recorder deletes the File Allocation Table (the list of files). This means that the data are not

erased, they are made re-writeable. There is also the option to reformat the recorder under

Instrument > Format Recorder which will delete everything on the recorder.

Note: Before you erase the recorder, make sure that you have transferred all the data you want to

retain. 
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Figure 22. Recorder data retrieval dialog box

To find the downloaded data, click File > Open Deployment Data Folder or click the link in the

dialog.
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5.6 Data Conversion

The Data conversion menu is used to convert the proprietary binary data files (.ad2cp) into various

formats. Multiple data files can be selected and converted at one time. Click Add File... This

displays a file selection dialog box where you can select files to add to the Files to convert list.

Press Start to initiate the conversion process. The converted data are located in the folder specified

under "Save in folder". This path is also clickable.

Export to Matlab format result in .mat files which are directly readable by MATLAB. There is also an

option to Export to .PD0 format which convert the file to standard PD0 binary format, or Export to

CSV format which can easily be used with Excel. It is possible to select Include coordinate

transformations which will automatically calculate the remaining two coordinate systems (e.g. if you

chose ENU, then BEAM and XYZ coordinates will be included). Note that this will approximately

triple the file size. The "Use 3D profile arrays" result in data saved in 3D arrays instead of 2D (which

is the default).

Figure 23. Data conversion dialog box

Data Format

.ad2cp and .cfg 

The format of these data files are described in the System Integrator's Guide. The .cfg is the

configuration file, the .ad2cp contain all raw data, stored in binary format.

.mat

Four structures are created. Data and Config contain sub-structures, Comments and Units that

provide text describing the contents of the structures. Note that this operation can result in large

amounts of RAM being used when processing large data files. Large data files will be broken down

into multiple smaller .mat files by the export process. When multiple files are produced, “_#” will be

added on to the file name prefix to identify each file portion.

.pd0

RDI Workhorse pd0 data format. See RDI documentation for details.
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.csv

Comma separated values format. Each line is a data record, each column is described with the

relevant header. Exports averaged data only for both raw .ad2cp files and _avgd.ad2cp files.

In order to get manageable file sizes out of the data conversion, there is a constraint of 50 Mb per

file. The result is that the .ad2cp file will be separated into a number of sub files during conversion,

depending on selected exported format and data size:

.mat and .pd0: Exports raw and averaged data, and these two types of files will be separated by an

_avgd extension on the averaged data file. Large data files will be broken down into multiple smaller

files, and _# will be added on to the file name prefix to identify each file portion.

.csv: Exports only averaged data, and the exported files will be separated into subfiles based on the

configuration. For example, if you measure Current Profile and Burst, you can expect to get files with

A0 and B0 in their names, respectively. If you in addition measure with alternating modes, you will

see A0, A1, B0, B1. A0 and B0 contain Current Profiles and Burst data from the content of

Alternating plan number one, and A1 and B1 is the Current Profile and Burst data from Alternating

plan number 2. Other file identifiers are IB0 to denote Burst data from the vertical beam, and RAB0 to

denote raw altimeter burst data. In addition, large data files will be broken down into multiple smaller

files, and _# will be added on to the file name prefix to identify each file portion.

Note that the above may not be relevant for your specific instrument. The Signature250 does not have

the option of alternating between two modes, and the Signature55 does not have concurrent

measurement plans.
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5.7 Post-Processing

The raw measurements captured by ADCPs often need to go through post-processing to yield usable

datasets. The post-processing software intended for the Signature series of instruments is called

Ocean Contour, and requires a paid-for license. If you would like a quote for the software, please

contact your local Nortek representative. Once you have a license, the software can be download

from our website.

Ocean Contour is a standalone, interactive desktop application that provides data visualization and

processing capabilities for acoustic Doppler systems, specifically Nortek's Signature series, other

AD2CP based instruments, and the Vectrino Profiler. Ocean Contour provides interactive QA/QC,

data averaging and wave processing in addition to the display of all data products from the supported

instruments.

5.8 Menus

The following commands are available on the main menu:

5.8.1 File

Open Documents Folder

Starts the Windows Explorer in order to find the folder where all the data files are stored.

Open Deployment Data Folder

Starts the Windows Explorer in order to find the folder where all the deployment data files are stored.

Open Online Data Folder

Starts the Windows Explorer in order to find the folder where all the online data files are stored.

Preferences

Sets the user data location and toggle for tooltips.

Exit

Disconnects from all instruments and exits from the application.

5.8.2 Communication

Connect to instrument

Initiates the Discovery feature which allows instruments to be found on the local network.

Disconnect from instrument

Disconnect instrument and returns the software to the startup screen.

Terminal Window

Access the Terminal Emulator to communicate directly with the instrument using commands. A

simpler way to  access the terminal emulator is to click Ctrl+T in the Discovery screen.

Open in Web browser 

The AD2CP network processor runs a web server for displaying basic information about the

instrument. To access the Web site, click here.

5.8.3 Planning

Recent deployments

Select a recently used deployment file. 

New deployment

https://www.nortekgroup.com/about/contact
https://www.nortekgroup.com/software
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Starts the Deployment Planning wizard.

Open deployment

Opens the location where deployment files are saved.

5.8.4 Deployment

Start recorder deployment

Initiates a deployment after selecting your .deploy file. Data will be stored on the instruments internal

memory card.

Recorder data retrieval

After a recorder deployment the data (.cfg and .ad2cp file) will be available on the recorder for

download. 

Data conversion

The Data conversion menu is used to convert the proprietary binary data files (.ad2cp) into Matlab file

format. Multiple data files can be selected and converted at one time. 

5.8.5 Online

Start Data Collection

An online measurement sequence is started by selecting your .deploy file. Data is collected over the

Ethernet or serial cable and can be seen in the Deployment software in real time.

Stop Data Collection

Stops online data collection.

Record Data

Enable before starting data collection if you want the online data to be recorded to disk. 

5.8.6 Instrument

Nickname

Opens a text field to enter a (new) nickname.

Compass Calibration

Use this command to display the Compass Calibration dialog box that allows perform an on-site 2D

or 3D calibration of the instrument compass to remove the effect of Hard-iron objects. 

Firmware Upgrade

Use this command to download new firmware to the instrument. When upgrading the firmware, check

to ensure that the most recent version of the application software is also used. Incompatible firmware

loads will be detected by application.  

1. Download the newest firmware to your computer from here: http://www.nortek-

as.com/en/support/software 

2. Click on Upgrade, select the relevant instrument and then browse to the downloaded firmware file

and select it. 

3. Click OK to start downloading the file to the instrument. This will result in the file being transferred

to the instrument and a progress bar will be displayed 

Erase Recorder

http://www.nortek-as.com/en/support/software
http://www.nortek-as.com/en/support/software
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Deletes the File Allocation Table (the list of files). This means that the data are not erased

completely, they are made re-writeable.

Format Recorder

This option will erase the recorder completely, not just the FAT as described above.

Set Pressure Offset

Set the pressure offset in dBar

Licenses

Add a new license to increase the available functions.

Show log

Use this command to display or edit the deployment log file.

Get Support File

Download the instrument support file (.tar.gz) containing debug information. This file is useful if you

need support.

5.8.7 Help

Help

Offers you an index to topics on which you can get help.

Manual

PDF versions of the Signature55/100 and Signature250/500/1000 operations manuals.

Release Notes

Open the software version release notes in your default text viewer.

Firmware release notes

Open the firmware version release notes in your default text viewer.

Nortek Web site

Open the Nortek home page in your web browser.

Check for updates

Check for more recent firmware or software versions, and select if this shall be done automatically. 

Download Firmware

The firmware is bundled with the software.

Support Files

Download the software support file (.txt) containing debug information. This file is useful if you need

support.

About

This item provides information about Nortek and how to contact us.
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6 Mechanical Aspects and Maintenance
Preventive maintenance is your primary tool to keep your instrument in shape and ready for action

and deployment. We recommend a regularly scheduled procedure which will act as a preventative

measure to ensure your instrument continues functioning as intended. The following sections can be

used as a maintenance guideline for the components that may be exposed to wear and tear.

We recommend conducting a Functionality Test after the maintenance procedure has been finished,

to ensure that the instruments functionality is as expected. For AD2CP instruments, we also

recommend adding an entry in the internal log that is kept within the instrument. This can be helpful

in assessing service intervals etc. The "Add Deployment Log Entry" box on the Logs tab in the web

interface can be used for this. This log will also keep a record of things like formatting or erasing the

recorder and firmware upgrades.

DO NOT EXPOSE THE ELECTRONICS

In general, there should be no reason to expose the instrument electronics. Do not open the

housing to expose the electronics unless instructed by Nortek.

Only qualified personnel are allowed to perform corrective maintenance activities. Please contact

Nortek for further assistance if in any doubt.

6.1 Instrument Care

All Nortek instruments are intended for use in water. Other fluids may have an adverse effect on the

materials used. 

For prolonged storage at elevated temperatures close to the specified limit, or when temperature

variation is uncertain, it is recommended that the screws securing the end cap be loosened in order

to minimize the risk of any deformation due to temperature/stress over time (if your instrument has

an accessible pressure case).

A preventive maintenance routine should include regular cleaning of the instrument. Use a mild

detergent and pay special attention to the transducers. Do not expose any part of the instrument to

harsh chemicals. Check the pressure sensor and remove any dirt from the holes in the cap. Be

careful when opening the pressure sensor cap as it is easy to dent the sensor.

Do not use the molded head or endbell as a clamping surface, always clamp to the instrument

housing.

When opening the instrument, great care should be taken to keep the sealing surfaces clean and

protected from mechanical damage. Keep water out of the open pressure case. Both fresh and salt

water can corrode the circuitry.

If the instrument has been subjected to environmental conditions outside the specified design limits

(refer to the Technical Specification for your instrument for the limits), mechanical tolerances of non-

metal components may be affected.

mailto:support@nortekgroup.com
mailto:support@nortekgroup.com
https://www.nortekgroup.com/products


Mechanical Aspects and Maintenance 45

Nortek AS

6.2 Connector Care

It is extremely important to keep connectors clean and well lubricated. Before plugging in connectors

we recommend to always blast the pins with compressed air, inspect them for cleanliness and then

protect the cable connector by applying a thin layer of silicone lubricating spray on the pins before

you plug it into the instrument. We recommend the 3M Silicone Spray. Do not use the silicone

grease included in the toolkit on connectors, as this is intended for O-rings only. 

Before deployment: 

· Demate the connector set. 

· Flush both halves of the connector set with compressed air and remove any dirt.

· Check that both connectors are dry. If not, let them air-dry.

· Inspect for damage, corrosion and cuts. 

· Apply a thin film of 3M Silicone Spray or equivalent. 

· Mate the connector halves, and mate any unused connectors with dummy plugs. Ensure the

rubber part of the female connector is properly seated over the pins before screwing on the locking

sleeve.

After deployment and before storage: 

· Flush both halves of the connector set with compressed air and remove any dirt.

· Check that both connectors are dry. If not, let them air-dry.

· Inspect for damage, corrosion and cuts. 

· Mate with a dummy plug.

6.3 Cable Care

To keep your cables in good condition:

· Avoid nicks and cuts around contacts, as these are the sealing surfaces.

· Do not pull on the cable to disconnect connectors; pull the connector itself.

· Avoid sharp bends at cable entry to connector. 

· Ensure that the cable is fixed to the mounting fixture to avoid mechanical stress to the

connection. 

· Elastomers can be seriously degraded if exposed to direct sunlight or high ozone levels for

extended periods.

6.4 Replace Desiccant Bag

Humid air can condense enough water do damage the electrical circuitry. At least once a year,

replace the desiccant located in the pressure case or the external battery canister. You may wish to

replace the desiccant bag more regularly if the instrument is exposed to multiple significant changes

in temperature (e.g. from a hot/humid surface environment to cool water). Refer to the battery

installation procedure for your instrument for instructions on opening the pressure case.

6.5 O-ring Care

O-rings are the critical component that keeps water out of the housing and thus the instrument dry.

Watertight sealing of the instrument housing is provided by double O-rings on the head and end cap

sub-assemblies. The outer O-ring forms the primary seal and the inner forms a secondary (or

backup) seal. If the integrity of the O-rings are degraded the instrument should not be re-deployed. In

this case, please contact us.

mailto:support@nortekgroup.com
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 If the instrument has never been opened, O-ring inspection is not necessary. However, when

changing batteries, the O-rings on the endbell are exposed. Make a routine of inspection,

maintenance and replacement of exposed O-rings.

· Check the O-rings and the O-ring grooves for grit, hair, lint, sand, or anything that could potentially

breach the O-ring seal. 

· After frequent deployments or if O-rings or groves appear dirty, remove O-rings and clean the

grooves. To remove O-rings, use finger pressure or the rounded edge of a plastic card to lift the O-

ring out of the grove. Caution! Never use a metal object to remove an O-ring. It may cause damage

to the O-ring or the sealing surface.

· To check O-rings for damage, place the O-ring between the middle and index finger and thumb.

Then pull the O-ring through your fingers, feeling for any debris or wear. 

· If O-rings are dirty, it is best to replace them. Washing dirty O-rings with soap and water is not

recommended. Soap breaks down the lubricants and will compromise the integrity of the seal. 

· Properly greased O-rings will help maintain sealing integrity and minimize O-ring degradation. Use

enough grease to lubricate the O-ring thoroughly, but not so much that it will attract additional

debris. 

· Clean the groove with a lint free swab or the folded edge of a paper towel. 

NOTE: Do not open the transducer end on your instrument to check O-rings. Opening the whole

instrument means exposing the electronics, and this shall not be done unless Nortek has approved

and provided guidance on how to do it.

6.6 Securing Screws

When installing end caps and sensor heads, care should be taken when tightening the screws. Just

a little tension on the screw is needed; when the O-ring starts to be compressed, turn each screw a

little at a time until the O-ring is fully compressed.

Tightening one screw fully before continuing on to the next may cause improper O-ring seating and

very high mechanical stress concentrated around the screw hole. This may cause leaks and/or

damage to the head or the endbell. The screws need only be tightened sufficiently for the O-ring and

spring washers to be fully compressed. Instead, use the cross tightening sequence: tighten one

screw slightly, then move to the screw opposite. Tighten that one slightly, then change to the next

pair of opposing screws and repeat. Continue in this pattern until the screws are sufficiently

tightened.

Over-torquing has no positive effect and may damage the threads and/or area around the screw holes

on the head and end cap. Keep in mind that ocean pressure holds the end cap tightly; all the screws

have to do is to secure the end cap from falling out when the system is above water.

Figure: a) "Two-fingers" tightening of screws. Indicator arrow shows position before final tightening. b)

Final tightening 30-45 degrees from "two-fingers" tightening.
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6.7 Biofouling

Marine growth, or fouling, on moorings should be considered when planning long-term mooring

systems. Current profilers used in long term monitoring projects will be covered with biological

material. Eventually, the growth can become strong enough that the transducers are blocked and the

profiling range is reduced. To know when to maintain the instrument it is best to monitor the long

term variation in the amplitude data. This parameter varies with short time scales (depending on

suspended sediment concentration, zoo plankton, bubbles, etc.), but biological growth (especially

barnacles) adds a long term downward trend that can be monitored. The profiling range gradually

goes down as the growth on the sensor increases. At some point, the signal strength will be too low

to achieve the desired profiling range. Through experience you will gain knowledge about how long it

takes before the transducers are covered and this information can later be used to set regular

maintenance intervals where the transducers are cleaned. 

When the instrument leaves the factory, the surfaces are quite smooth and it will take some time

before any growth starts. After the first cleaning, the surface is rougher and it becomes easier for new

material to grow. Typical maintenance intervals are 6-12 months, but the growth rates vary a lot with

the geographical location, water temperature, season, and deployment depth. In general, heavy

growth is seen in hot and shallow areas. Cold and deep water areas see very little growth so

maintenance can be less frequent. 

When calculating forces, the marine growth is accounted for by increasing the expected weight and

diameters of the mooring line and all instrumentation attached, in addition to increasing the drag.

Antifouling paints and other agents are often used to avoid transducers being covered with barnacles

or other evil crustaceans during long deployments. The important thing when it comes to antifouling

is that the paint is not too thick, otherwise the signal strength may be affected. Nortek has tested the

effect of antifouling paints on the profiling range of the 2 MHz Aquadopp and no appreciable change

was found when a thin (1 mm or so) layer on the transducers was applied. You can probably use

most anti-fouling paints as long as it is not too (chemically) aggressive and contains no solids (metal

flakes, etc.) that could interfere with acoustic beams. Anodes and pressure ports should not be

painted.

Nortek has run a test with three different zinc oxides, a zinc paste with 40% zinc oxide, Silulen

(Nycomed) with 20% zinc oxide and Desitin (Pfizer) 40% zinc oxide. They all work quite well but the

Silulen a little less so. Our conclusion from the test was that a higher zinc oxide percentage is

probably better. Other options are use of thin plastic bag or Pettit's Trinidad anti-fouling paint (75.8%

cuprous oxide). A different approach is to use an anti-fouling adhesive patch that covers each

transducer. These patches have doubled deployment lengths in warm, biologically-active waters by

keeping the transducers clear for longer and greatly increasing the required maintenance interval to

remove biofouling. They have no detrimental effect on the quality of the measurements from covered

transducers. Contact your local Nortek representative for more information.

We realize barnacles have to be removed mechanically, but we strongly advice against using sharp

objects capable of harming the polyurethane surface. We also recommend staying away from strong

organic solvents such as acetone. A common, easy, and inexpensive way to keep the Delrin housing

on the Aquadopp and Aquadopp Profiler clean is to wrap the housing in either clear packaging tape

and/or clear plastic wrap (such as the brand name "Saran Wrap"). At the end of the deployment,

simply unwrap the protective coating to find a clear instrument. Tapes such as "Duct Tape" can leave

a sticky residue that is very difficult to remove (although it does not actually harm the Delrin housing).
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7 Troubleshooting
This section contains information in where to start looking if an instrument does not behave as

intended. If you encounter a problem, you should:

· Get a good overview of the problem; make notes during the troubleshooting process

· Work in a systematic way and do not neglect the obvious. Start by looking at simple causes, such

as power not connected, bad connections, etc. 

· If the setup uses custom cables, power supply, etc. first assemble and test the instrument using

the cable and battery (if applicable) that originally came with the instrument. You can always return

to the standard setup, which is the easiest way to get the system to work, to confirm that the

problems are not caused by a faulty instrument.

· If your instrument behaves strangely try updating both your software and firmware to the latest

versions. There may be incompatibility between an older version of firmware and newer version of

software, and vice versa. The latest versions of firmware and software can be downloaded from our

support page at http://www.nortekgroup.com/software 

To help us give good support, please:

· Be specific about the error - a screenshot is often helpful

· Include a raw sample file or a collected data set showing the error (.ad2cp)

· Include information about firmware and software version used

· Include serial number (Head ID, Hardware ID or order number)

· A Support file can be downloaded from the instrument and is used to assist you in the best

possible manner. To retrieve this file, click Instruments > Get Support file. Alternatively, type in

the IP address in the web browser and click “Retrieve Support File”. A *.gz file is then downloaded

and can be sent directly to Nortek for diagnosis. 

If it turns out that the instrument will have to be sent back to Nortek for repair, check out the FAQ on

RMAs for more information. Make sure to include all the information requested in the Proforma

Invoice document. You can provide your own, or use our example shown in Appendix.

NOTE: Do not open the transducer end on the Signatures when doing troubleshooting. Opening the

whole instrument means exposing the electronics, and this shall not be done unless Nortek has

approved and provided a guidance on how to do it.

7.1 Communication

Instrument connected through Ethernet cable

· Does the Ethernet cable have a source of power?

· If the instrument is visible in the Discovery screen, try right-clicking and opening the Terminal

Emulator. Send Break then Switch to Command Mode, a confirmation message should appear.

Try connecting to the instrument as per normal.

· Consult the Universal Plug and Play section to find the IP address. Type this in the Discovery

screen of the Deployment software. If you are able to connect, but it does not appear in the menu

there may be an issue with the firewall. Try disabling your firewall and refresh the Discovery

screen.

· Check network cabling connection: If your computer has light emitting diodes (LEDs) next to the

connection where the Ethernet cable plugs into the computer, check if the LEDs are lit to indicate

the current status of the network device. If the LEDs are not glowing/blinking, check that the

connector is OK and try to re-plug. Refer to your computer's manual for information about the

Ethernet port LED.

http://www.nortekgroup.com/software
http://www.nortekgroup.com/faq
http://www.nortekgroup.com/faq
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· Check the LED on the switch or router. The LEDs should be lit when there is a connection

between the computer, the network router or switch and the instrument. If not, try switching it on

and off to reset the switch/router. 

· If an Ethernet switch is used, its Ethernet port should also show an active Ethernet link. Try

connecting with a different cable. If not, there is a problem with the computer connection.

· If you have a button for turning on/off the wireless network antenna on your computer, turn this off.

· Connect the communication cable directly from the computer to the Signature instrument to

bypass all of the network wiring and router. Is the PC showing that the link is active?

· If the connection was lost all of a sudden; run a test and analysis function in Windows (see step-

by-step description below)

Figure 24. Ethernet port lights on

computer.

Test and Analysis function in Windows

1. Click "Start"

2. Click "Control Panel"

3. Click "Network and Sharing Center"

4. Click "Change Adapter Settings"

5. Right-click “Local Area Connection". This icon represents your Ethernet connection to the

instrument

6. Click "Diagnose." The analysis function in Windows will examine the failed connection and show

an explanation of the problem and some advices to fix the problem

Unlike the serial port, once you have verified that the link is active, there is no need to do anything

else with configuring the speed or other link characteristics. The next step is to make sure you have

got an appropriate IP address assigned. For details about the process of assigning IP addresses,

refer to the Appendix.

Instrument is connected through serial communication cable

· Does the instrument have a source of power? Try using both internal and external battery/power

source.

· Ethernet still connected and powered. The Signature will prioritize an Ethernet connection over a

Serial connection, so if both cables are plugged in and powered only Ethernet will be available.

· Wrong serial port. Check that the correct serial port is selected. Go to Start - Control Panel -

Systems - Hardware - Device Manager - Ports (look for USB device)

· Wrong baud rate. Try sending a break in the Terminal Emulator. If gibberish/non-sense or nothing,

check the baud rate settings.

· Wrong serial protocol for the cable. Signatures can use both RS232 and RS422. Use the

command GETINST,RS to check which protocol is enabled.

· There is a problem with the converter. Check that the LED on the converter is lit. If not, confirm that

the correct driver is installed.
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The blue LED indicator light on the instrument is not lit

· Is the instrument in Command mode?

· Does the LED blink (short) when applying power?

Cable

Cables are often exposed to heavy use and the power connector might break. Using a multimeter to

ping through each pin may reveal a breakage.

Power Supply

The power supply supplied with the Signature series comes with a plug that it is possible to attach it

incorrect. The Signature is protected by diode against reversal of polarity, but it will not power on.

Figure 25. Make sure the plug on the power supply is

correctly fitted if it has been disconnected earlier

7.2 Network

Firewall

Firewalls are usually active by default and could be a possible cause for blocking communication. 

For organizations with strong security / firewall restrictions, FTP access to the instrument may not

be permitted. HTTP (Hypertext transfer protocol) can then be used for data transmission. A web page

allowing individual data files to be downloaded has been implemented in the Ethernet processor. The

web page can be accessed by clicking on the “Data Download (HTTP)” link from the main web page.

Routers

There are some limitations to the discovery protocol.  Multicast Ethernet packets are used to

implement the protocol and those packets may not be forwarded through routers (depending on the

router type and configuration). For that reason, the instrument should be either directly connected or

connected through a single Ethernet switch for troubleshooting. Once the IP address is properly

configured, it can be used to access the instrument using normal IP communications. Only the

discovery protocol uses multicast packets. For more details about the Ethernet communication, refer

to the Appendix.

IP address

You have the possibility to enable/disable DHCP and set a static IP address, if necessary. Check

out this appendix for details.

7.3 Software Problem

Discovery tool; the instrument I want to connect to has red background. The instrument cannot be

connected to because of one of the following reasons:

· Non compatible firmware. Go to Help > Download Firmware to get the most up to date version.

· Instrument is on wrong subnet. This can be fixed automatically by double-clicking the instrument

name while in the Discovery screen.
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· The instrument listed is not supported by the software.

If the Discovery feature does not list your instrument, refer to the Communication Problem section.

Software crash

· Download the support file containing debug information: Help > Support files

· If your instrument behaves strangely (for example error messages when trying to start data

collection, compass calibration or pressure offset calibration), update both your software and

firmware to the latest versions. There can be incompatibility between an older version of firmware

and newer version of software, and vice versa. The latest versions of firmware and software can be

downloaded from our support page.
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8 Appendices

8.1 Glossary

Accuracy A value giving the degree of closeness of a velocity measurement to the actual

velocity. Refer to the data sheet for specific minimum accuracy.

AD2CP Nortek's broadband signal processing platform. 

AHRS Attitude and Heading Reference System. Provide attitude information and replace

the traditional tilt and magnetometer. AHRS is especially useful in dynamic

environments. Note that this feature also requires additional hardware.

Altimeter Measures the distance to the surface

Amplitude See signal strength

ASCII output Data is displayed in ASCII format (text).

Bandwidth Wider signal bandwidth is used to get more information and improve the velocity

precision. Reduced bandwidth is used in long range mode (only relevant when

current profiling) to increase range. This bandwidth reduction makes the

measurements less precise.

Beam

Coordinates

In Beam coordinates, a positive velocity is directed in the same direction as the

beam points. Beam 1 is marked with an “X” on the head. 

Blanking Specifies the distance from instrument head to the start of the measurement cell

where no measurements take place, to give the transducers time to settle before

the echo returns to the receiver. The size of the blanking area is user selectable

in the software using the Start of profile parameter. 

Break A break command is used to change between the various operational modes of

the instrument and to interrupt the instrument regardless of which mode it is in.

When break is received in command mode, you can see that the LED is

switched off for a short time.

Broadband In this context it means using a more complex transmit pulse to improve the

measurement accuracy in each ping.

Cell One measurement cell represents the average of the return signal for a given

period. The cell size and transmit pulse are of equal size. The cell is shaped like

a triangle due to convolution; this is indicative of the weighting of the

measurement. 

Coarse Profile Instrument setup that prioritize achieving the maximum range at the expense of

reduced resolution.

Command

mode

An instrument in command mode is powered up and ready to accept your

instructions. If no commands are received for about five minutes, it automatically

goes into Power Down Mode, unless Ethernet power is connected. LED is lit

constantly when in command mode.  

Compass

calibration

Each compass system has been calibrated at the factory to quantify the

characteristic response of the individual components and of the system as a

whole. When it leaves the factory, each system can measure its tilt and the

direction of its magnetic field vector accurately. However, users may disturb the

magnetic field near the instrument when they deploy. Adding a battery pack and

mounting the instrument with deployment hardware adds magnetic materials that

change the earth's field at the instrument. The compass calibration procedure
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quantifies this magnetic hard iron disturbance, and the instrument's compass

algorithm then corrects for it to obtain accurate heading.

Correlation

(nominal)

Nominal correlation is a function of cell size and velocity range. Nortek

recommends using 50% of the max correlation as a cut-off value, beyond this

point the validity of your data is questionable. 

ENU

Coordinates

Polar magnetic coordinates; East, North and Up. A positive east velocity goes

toward east. This is also a right-handed orthogonal system.

Fine Profile Instrument setup that prioritize the highest possible resolution at the expense of

the maximum range achievable.

Firmware Internal software of the instrument, as opposed to the instrument software

running on a PC. New firmware is posted on the Nortek site. You will need to

register to get access, but access is otherwise free of charge.

HR High Resolution. With the correct firmware and license, the instrument can

measure High Resolution data on the fifth, vertical beam.

Ice Draft (keel) Measures thickness of ice. Ice draft = Water depth - Distance to Ice

Ice Drift With the correct firmware and license, measures velocity and direction of ice

drift.

Internal

sampling rate

Rate of sampling for internal sensors. Refer to the specific instrument brochure

for details.

LED Light Emitting Diode, visible from the outside of the instrument. The LED can be

set to blink for every sample (On), blink for the first 24 hours of deployment (On

for 24h), or never (Off). 

License Different capabilities of the instrument are protected under licenses which can be

purchased. Contact your sales representative for more information. Register

purchased licenses while connected to your instrument under Instrument >

Licenses. Licenses that are ordered with the instrument are already registered.

You will not need a license when updating the firmware version.

NMEA Standard data format defined by the National Marine Electronics Association

Noise floor The amplitude of the internal noise of the instrument. This will limit the minimum

detectable signal that can be received.

Ping Same as a single transmit pulse.

Precision The value given is a theoretical estimate of the precision of the velocity

measurements based on how the instrument is set up. The nominal value is

given for the horizontal components in a default instrument acoustic beam

configuration. In order to improve the precision the user may consider one of the

following options: (1) larger cell sizes, (2) longer average interval (3) reduced

velocity range, or (4) increased measurement load

Sampling rate Specifies the rate at which data is output

SDU

Coordinates

Speed - Direction - Up.

Sidelobe The acoustic beams focus most of the energy in the center of the beams, but a

small amount leaks out in other directions. Transducer sidelobes are rays of

acoustic energy that go in directions other than the main lobe. Because sound

reflects stronger from the water surface than it does from the water, the small
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signals that travel straight to the surface can produce sufficient echo to

contaminate the signal from the water. 

Signal strength Strength of return signal, presented in dB.

Sleep mode The instrument is not actively collecting data

SNR SNR is the Signal-to-Noise ratio and is a data quality indicator.

XYZ Coordinates Cartesian coordinate system. A positive velocity in the X-direction goes in the

direction of the X-axis arrow. The X-axis points in the same direction as beam 1.

Use the right-hand-rule to remember the notation conventions for vectors. Use

the first (index) finger to point in the direction of positive X-axis and the second

(middle) finger to point in the direction of positive Y. The positive Z-axis will then

be in the direction that the thumb points. 
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8.2 Communication and Ethernet

Connections between the instrument and computer can be made in one of two ways.

 

· Ethernet (via direct connection or router/switch) 

· RS232/RS422 through the serial port. Serial communication baud rate: 300-115200, 230400,

460800, 625000, 1250000

Details about the Ethernet connection

Most instruments are shipped with the Ethernet option. The first time using the instrument, the

network address needs to be properly configured for the network. The IP address can be assigned in

one of the three ways: 

1. Dynamic Host Configuration Protocol (DHCP): A DHCP server in the network is used to assign an

IP address to the Ethernet interface. 

2. AutoIP: Link-local address assignment.

3. Manually assign IP address (by the user)

As shipped, the instrument uses options 1 and 2. This means that it will try to automatically

configure the IP address for the network that the instrument is plugged into. 

If a DHCP server is detected it takes approximately 30 seconds to negotiate for and assign an IP

address to the Ethernet interface. If you are using a broadband router, it is likely you are using a

DHCP Server to assign IP Addresses. Common private network address schemes include

192.168.x.x and 10.0.x.x subnets, with the Subnet mask of 255.255.255.0 or 255.255.0.0

If a DHCP server is not detected (usually because of being directly connected to a computer) and the

request for an IP Address is not fulfilled, the Signature system will automatically assign itself IP

addresses using the AutoIP protocol. DHCP must first time out before the AutoIP protocol starts, so

this will result in a delay of approximately 90 seconds before an IP address is finally assigned. A

standard AutoIP address sits in the 169.254.x.x range, with the subnet mask being 255.255.0.0. 

When using automatic IP address assignment, there is generally no way of knowing which address

was assigned to the instrument. To determine the IP address assigned, the Discovery protocol is

used to query instruments on the local subnet. The discovery protocol is a Nortek proprietary means

for retrieving information from an AD2CP without requiring any knowledge of the IP address

assigned. 

There are some limitations on the Discovery protocol. It uses a special type of Ethernet packets

(known as multicast packets) that may not be forwarded through routers (depending upon the router

type and configuration). For that reason, we always recommend that the computer being used for

Discovery ONLY be either directly connected to the instrument or connected through an Ethernet

switch. Only the Discovery protocol uses multicast packets. Other communications use standard

TCP/IP networking which means that the instrument can be communicated with anywhere that IP

connectivity is supported once the IP address is known.

For more details about the DHCP or AutoIP there are many articles available in the public domain.

These are standard protocols used by most Internet based equipment. 

Routers

The discovery protocol uses multicast packets that may not work through firewalls and routers. The

Time-to-Live for the multi-cast packets is set to 2. This means that at most one router can sit
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between the acquisition system and instruments. The router must also be configured to support

forwarding of multicast packets.

Manually assign IP address

Networked instruments can also have their IP address manually assigned. This may be useful on

networks in which the discovery protocol might not work (e.g. through multiple routers or firewalls).

Network Configuration

Right-click the highlighted instrument in the Discovery function dialog to get the option of enabling

DHCP or set a static IP address or IP address for a local interface (see screenshot of the dialog

below).

Enable DHCP: Use a dynamically assigned IP address from a DHCP server or from AutoIP instead of

a user supplied IP address. The IP address that gets assigned is also shown in this panel. AutoIP

allows a local domain dynamic IP address to be assigned without the presence of a DHCP server. An

instrument connected directly to the host will be assigned a special address in the 169.254.xxx.xxx

address range. In order for the Windows host to also select an appropriate address in this case, the

Automatic private IP address option in the Internet Protocol Version 4: Alternate Configuration menu

must be enabled. 

IP address: The IPv4 address to manually assign to the network interface. 

Netmask: The network mask used to identify the local subnet for the network. 

Gateway: The router address used to connect to machines that are on a different subnet from the

instrument. The gateway must be on the same subnet as the IP address selected. 

Local Interface: Shows which network interface on the computer is being used to communicate with

the instrument and whether or not full IP communications can be established.

Make sure the Network adapter is configured to obtain IP address automatically and is not set to

"fixed". This setting is found under Network and Sharing Center > Change Adapter Settings. Right-

click the relevant network and open "Properties".

Telnet, Raw connection and FTP

The serial interface of the Doppler processor is accessible over telnet. A dedicated port can be used

for ASCII only communication whereas another port provides the complete set of data, including

binary data output of the measurements. This subject is covered in the System Integrator's Guide,

please refer to this guide for more information.

http://www.nortekgroup.com/manuals-quick-guides
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8.3 Terminal Emulator

The Terminal Emulator window allows you to communicate directly with the instrument using

commands. To open the Terminal Emulator connect to the instrument using the Deployment software

and click Communication > Terminal Window or while in the Discovery screen highlight your

instrument and press Ctrl + T. You can also right-click the specific instrument and select the

Terminal Emulator option.

Figure 26. Terminal Emulator dialog

Command: Specify a command to send to the instrument, e.g. ‘ID’ to get the identification string.

Note the existence of a right-click menu, which is useful if you need to edit commands. Press the

Send button to send the command to the instrument. ASCII commands may be typed directly in the

terminal window. Refer to the System Integrator's Manual for a list of commands and their syntax.

Up/down arrows can be used to access the command history, and the terminal window command

history are kept within sessions.

Send: Sends the command specified in the Command field.

Send Break: Sends a BREAK signal over the port. A break causes the instrument to report an

identification string when it is in command mode:

Signature1000 - NORTEK AS.

Version 2182_3 (Sep 17 2015 18:31:28)

COMMAND MODE

OK

Protocol: Select NMEA format if applicable

Decoding

· ASCII: Display instrument output in ASCII format. 

· Hex: Display instrument output in hexadecimal format. 

Record data: Lets you capture the data to file.

Upload file...: Specify the name of a file containing an ASCII command to send to the instrument.

Switch to Command Mode: Put the instrument in command mode. 
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8.4 Web interface

The AD2CP network processor runs a web server for displaying basic information about the

instrument. To access the Web site, first make sure you are connected to an instrument. Find the

instrument in the Windows Explorer > Networks and double-click. Check out "Properties" for more

details about the system. Alternatively, you can use the IP address of your instrument and type this

directly in the address line in your web browser.

From the web site you have access to:

Network configuration

The Network Configuration page provides another mechanism other than Discovery for changing the

saved instrument name and IP addressing information. Changing the IP address will result in the URL

in the web browser having to be updated with the new IP address. 

Maintenance

This area present system information and let you set the clock. Also upgrades and updates, erasing

and reformatting the SD card is possible from here. The Retrieve Support File button is used to

collect internal logs and run-time information for both processors into a single file (*.gz) that can be

sent to Nortek for analysis. The instrument must be in command mode for a complete support file to

be generated. 

Logs

These files are useful if you need support. The Instrument log contains production information, the

Deployment log contains instrument usage history. The Add Deployment Log Entry enables the user

to add entries to the deployment log. The Network  and System logs are mainly for debugging

purposes.

Security

Password protection may be used to restrict access to the instrument. In order to enable or disable

password protection, the password for the “nortek” account must be entered first (this to make sure

that the password is known prior to enabling protection and to prevent protection from being disabled

by an unauthorized person when enabled). Two passwords are available: one for the real-time

interfaces (the ASCII, raw and data interfaces; see the Integrator’s Guide) and one for FTP access to

the instrument recorder. The default password for both accounts is the same as the username

(“nortek” for the nortek account and “nortekftp” for the nortekftp account).

Data Download (HTTP or FTP)

Download data from the instrument. Note that this will interrupt running measurements.
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8.5 Universal Plug and Play

In addition to the proprietary discovery protocol, the UPnP (universal plug and play) protocol is

supported by the AD2CP platform. This allows the operating system which are UPnP capable to

discover the instrument with no need for proprietary software. To view the instrument icon in Microsoft

Windows, open the Network view of the computer.

Figure 27. Network view

Double clicking on the instrument icon brings up the web page interface. Right clicking and selecting

Properties gives the IP address and other instrument configuration information.

 

Figure 28. Properties

In order for UPnP to operate on Microsoft Windows platform, Network Discovery needs to be enabled.

This is normally enabled by default on "Home" and "Work" networks but disabled on "Public"

networks. To see if Network Discovery is enabled, open the Network and Sharing Center (Control

Panel: Network and Internet: Network and Sharing center) and click on the Change advanced sharing

settings selection. This will bring up the various network types (Home/Work/Public). Select the

network type that the instrument is connected to and ensure that Turn on network  discovery is
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selected for that network. If the network is a public network, it is recommended that network

discovery be turned off after interaction with the instrument has been completed.

8.6 Synchronization

The Signature series has advanced synchronization features built in, either using Ethernet PTP,

hardware trigger signals, serially through a command or trigger on a differential RS485 compatible

hardware signal. The instrument can also be configured to be a synchronization master, outputting

an RS485 sync pulse. This allows several Signature instruments to synchronize their sampling with a

small increase in power consumption. The various synchronized units must be identical (for example

only Signature500s) and use the same ping scheme. For more details about the different

synchronization options, check out the Integrators Guide - AD2CP.
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8.7 Connector Pin Configurations

Other Connector Pin configurations are available upon request.

6-pin connector, Standalone, Ethernet (N2550-003, N2550-008)

Connector on

the

instrument

side

Pin

numbe

r

Function Wire

color

Join

t

Wire color Pin

numbe

r

Connector on the

computer side

MCIL6M with 

MCDLS-F

(red)

Male face

view:

1 Gnd Black Black Jacket 2-pin jack plug

2 Pwr+ Red White Center

3 Rx- White Green 6 RJ 45 insulation

connector
4 Rx+ Blue Green/White 3

5 Tx- White Orange 2

6 Tx+ Orange Orange/Whit

e

1

2-pin connector (N2100-608)

Connector on

the

instrument

side

Pin

numbe

r

Function Wire color Pin

number

Connector on the external

canister

MCIL2M-G2

with MCDLS-

F(red)

1 Pwr + Twisted pair,

Red/Green

1 IL2M with DLSA-M(red)

2 Gnd Twisted pair,

Black/White

2

8-pin connector, Serial communication w/RS485 sync (N2550-021)
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Connector on

the

instrument

side

Pin

numbe

r

Function Wire

color

Join

t

Wire color Pin

numbe

r

Connector on the

computer side

MCIL8M with 

MCDLS-F

(red)

1 Gnd Black Black Jacket 2-pin jack plug

2 Pwr+ Red White Center

3 RS232 Tx

/ RS422

Tx-

White Red 2 9-pin DSUB

4 RS422

Tx+

Blue White 8

5 RS232

Rx /

RS422

Rx+

White Orange 3

6 RS422

Rx-

Orange Purple 7

7 Sync A White Blue 1 2-pin terminal block

8 Sync B Green Black 2

7-pin Souriau connector (10M), Online, Ethernet (N2550-016) - Signature500, Signature1000

and Signature250

Connector on

the

instrument

side

Pin

numbe

r

Function Wire

color

Join

t

Wire color Pin

numbe

r

Connector on the

computer side

7-pin Souriau

(FED 10M)

1 Gnd Black Black Jacket 2-pin jack plug

2 Pwr+ Red White Center

3 Rx- Green Green 6 RJ 45 insulation

connector
4 Rx+ White Green/White 3

5 Tx- Blue Orange 2

6 Tx+ Orange Orange/Whit

e

1

7 Shield Uninsulated 8

7-pin Souriau connector (14M), Ethernet (N2550-014, N2550-015) - Signature55
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Connector on

the

instrument

side

Pin

numbe

r

Function Wire

color

Join

t

Wire color Pin

numbe

r

Connector on the

computer side

7-pin Souriau

(FED 14M)

Male face

view:

1 Gnd Black Black Jacket 2-pin jack plug

2 Pwr+ Red White Center

3 Rx- Green Green 6 RJ 45 insulation

connector
4 Rx+ White Green/White 3

5 Tx- Blue Orange 2

6 Tx+ Orange Orange/Whit

e

1

7 Shield Uninsulated 8
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8.8 Proforma Invoice
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